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Conference PlaceSM            
User Guide 
Setting up Conference Place 
At the Login to ConferencePlace.com page, enter your User Login ID in the Login Field 
box, enter your password in the Password field, and then click Login. 

CHANGE YOUR PASSWORD AND SET OTHER USER PREFERENCES 

In your Meeting Manager, you can change the user password to one that is easier for you 
to remember. You can also set other user preferences for your account. 
 
To change your password 
 

1 On the Conference Place My Home page, click User Preferences. 
2 In the Old password box, enter your current password. In the New password box, 

enter your new password. In the Confirm new password box, enter the new 
password again. 

3 Click OK. 
 

 
 
If you need to make changes, select the appropriate option, make the necessary change, 
and then click OK. For more information, see How to Set User Preferences. 

SET AND TEST OPTIONS FOR MEET NOW MEETINGS AND FOR 
SCHEDULED MEETINGS 

Conference Place provides two kinds of options that you should set before meeting with 
other participants: 
 



  

 Meet Now options apply to unscheduled meetings that are initiated spontaneously 
(Meet Now meetings). Meet Now functions as a virtual workspace where you can 
invite participants to meet without formally scheduling a meeting. 
 Scheduled meeting options apply to meetings that you schedule in the traditional 
manner. For example, scheduled meetings have a start and end time. 

 
In many cases, your meeting options will be already set for you. However, you should 
ensure that your InterCall® audio settings are set correctly. Audio settings include your 
Reservationless-PlusSM “800” number, conference code, and leader PIN.  
 
For information about setting and testing your audio options, see How to Set Up Audio for 
Conference Place. 
 
For information about setting all other user options for Meet Now meetings and scheduled 
meetings, see How to Set Meeting Options. 
 
To test Meet Now options 
 

1 On the Meet menu, click Meet Now. 
2 On the Attendees menu, click Send E-mail Invite. 
3 In the Attendees and Presenters boxes, type your full e-mail address, for 

example, someone@example.com, and then click Send. 
4 In your e-mail program, open the invitations that you just sent. You will receive 

one for your role as presenter and another one for your role as attendee. The 
messages may take a few minutes to arrive. When they do, open the invitations 
and ensure that the audio conferencing information is correct, including the audio 
conferencing number and the participant passcode. 

 

 
 
To test scheduled meeting options 
 

1 On the Meet menu, click Schedule Meeting. 
2 In the Attendees and Presenter boxes, type your full e-mail address, for example, 

someone@example.com. 



  

3 In the Start box, select the current time as the start time. In the End box, select 
an appropriate end time. 

4 Click Send Invitations to send the invitations to yourself. In your e-mail program, 
open the invitations that you just sent. The messages may take a few minutes to 
arrive. When they do, open the invitations and ensure that the audio 
conferencing information is correct, including the audio conferencing number and 
the participant passcode. 

 

 
 

DOWNLOAD ADD-INS 

Conference Place Powered by Office Live Meeting offers add-ins that integrate with other 
Microsoft® products. The Outlook® add-in adds a Live Meeting menu directly in Outlook, 
making it easier for you to schedule Conference Place meetings. 
 
To learn about and install the add-ins that are currently available for Conference Place, 
visit the Conference Place 2005 Downloads page. Each add-in includes additional 
information about specific Conference Place tasks the add-in can help you with. 
 



  

 

CHECK YOUR CONFERENCE PLACE SETUP 

The best way to check your Conference Place setup is to actually use Conference Place 
to schedule a few test meetings and to meet instantly by using Meet Now. To get started 
with this process, see How to Get Started Quickly. 
 

 
 



  

Setting User Preferences 
User preferences provide basic information about you to the Conference Place service, 
including your name, your e-mail address, your Conference Place password, and your 
display and recording preferences. You control user preferences in two places: 
 

 Conference Place Manager 
 Conference Place Online Meeting Console 

 
Some preferences can be controlled in both the Conference Place Manager and the 
Conference Place Online Meeting Console. When you change one of these user 
preferences in one place, the change is reflected in the other. 

SET YOUR USER PREFERENCES IN CONFERENCE PLACE 
MANAGER 

You can use Conference Place Manager to control your personal information, connection 
speed, and access to recording. If you install the Conference Place Add-In Pack, you can 
also control add-in setup in the Conference Place Manager, or you can access these 
preferences in the Start menu on your Microsoft Windows computer. 
 
To set your user preferences in Conference Place Manager 
 

1 On the My Home page, under Manage, click User Preferences. 
2 On the User Preferences page, enter the following information: 

 

 
 

- In the Personal Information section, type your first name, last name, and full e-
mail address (for example, someone@example.com). 

- In the Password section, you can change your password. To do so, type your old 
password in the Old password box. Type your new password in the New 
password box, and then type the new password once again in the Confirm new 
password box. 



  

- In the Display Options section, indicate the number of meetings or recordings you 
want Conference Place Manager to display on a single page, and select your 
local time zone. 

- In the Recording Access section, if you want to require the e-mail address and 
company name of participants who want to access recordings, select the Require 
extended registration by asking for email and company name check box. To 
allow anybody to download meeting recordings, or to allow only meeting 
organizers to download recordings, click the appropriate option. 

3 Click OK to save your user preferences. Conference Place will use these 
preferences for all the meetings that you attend. 

Getting Started with Conference Place  

HOW TO JOIN A CONFERENCE PLACE SESSION 

Joining a meeting in Conference Place may seem simple but the more you know about 
joining, the more productive you can be. For this tutorial, we will take you through the 
process of joining a meeting, both as an attendee and a presenter. We will study the 
meeting invitation, which is your entry point into the meeting, and help you understand 
how to use the information in the invitation to get into the meeting. 
 
Once you are in the meeting, we will give you the directions needed to connect to audio. 

 Join from an e-mail invitation 
 What to Expect and How to Handle the First-Time Console Install 
 Join an InterCall® Reservationless-Plus  audio conference 
 Find a Meeting Invitation 

JOIN A MEETING FROM AN E-MAIL INVITATION 

 

 
Typically you will join a Conference Place session from an e-mail invitation that you 
receive in your mail client Inbox. The invitation may be for a scheduled meeting or for an 
informal Meet Now meeting (where a co-worker has just sent you and invitation to meet in 
their virtual workspace). The e-mail invitation contains the information that you need to get 
into the meeting and to connect to the audio portion of the meeting. 



  

TO JOIN A CONFERENCE PLACE SESSION FROM AN E-MAIL 
INVITATION 

1 In the e-mail invitation, click the Join Meeting link to go to the Conference Place 
Join Meeting page. 

2 On the Join Meeting page, you will probably be required to enter Your Name, the 
Meeting ID,and the Meeting Key as specified by the meeting organizer. The 
Meeting ID and the Meeting Key are contained in the e-mail invitation you 
received for the meeting. Your Name is the display name that appears in the 
Conference Place console and identifies you in the meeting. The Meeting ID 
identifies the meeting, and the Meeting Key provides password protection for the 
meeting. 

3 On the Join Meeting page, enter the following: 
 
JOIN 
MEETING 
PAGE FIELD  

 
DESCRIPTION AND HOW TO FIND AND ENTER THE INFORMATION 

Your Name  This is a friendly name that identifies you to other meeting members. Your 
Name can be your full name, your first name, your e-mail alias, or however 
you want to be identified in the meeting. Because this information is not in the 
meeting invitation, type the name you want into the Your Name box.  

Meeting ID  The Meeting ID is contained in your e-mail invitation. Copy the Meeting ID 
from the e-mail invitation and paste it into the Meeting ID field on the Join 
Meeting page.  

Meeting Key  The Meeting Key information is supplied as the Attendee Key or the Presenter 
Key information in the e-mail invitation, depending on whether you were 
invited to the meeting as an Attendee or a Presenter. From the e-mail 
invitation, copy the Attendee Key or Presenter Key (depending on your 
invitation), and paste the key into the Meeting Key box.  

 
4 After you have entered the required information in the Join Meeting page text 

boxes, click Join Meeting. 
 

 
 
 



  

WHAT TO EXPECT AND HOW TO HANDLE THE FIRST-TIME 
CONSOLE INSTALLATION 

 
 There are a variety of ways to join a meeting. The way you join a meeting depends 
on the access controls that the meeting organizer sets for the meeting. If the 
organizer has set the meeting up so that anybody can attend without a meeting ID 
or Meeting key, then you can enter the meeting by simply clicking Join. 

 
If You Haven’t Installed the Conference Place Console (or have a Console that is Out-of 
Date) 
 

 If you try to join a meeting, but haven’t installed the Conference Place console or 
have a console that is out of date, you will see the Meeting Installer page. 

INSTALLING THE WINDOWS-BASED CONFERENCE PLACE 
CONSOLE 

 
 If you are running on a Windows platform, we recommend that you click Install the 
Windows-based Conference Place Console. This is a one-time install that will set 
up the full-featured Conference Place Windows-based console on your PC. 

 
To install the Windows-based Conference Place Console 
 

1 On the Meeting Installer page, click the Install the Windows-based Conference 
Place Console link. 

2 On the File Download dialog box, click Run. If you are running Windows XP SP2, 
you may notice that nothing happens. If this is the case, go back to the Meeting 
Installer page and look for the popup that says "To help protect your security, 
Internet Explorer blocked this site from downloading files to your computer. Click 
here for options". 

3 Click this pop-up and then click Download File. When you see the File Download 
dialog box, click Run. Click Run again in the Internet Explorer Security Warning 
dialog box to start the Conference Place setup. When the installation is complete, 
Conference Place will launch the console and place you into the meeting. 

 

 



  

 
 
 
If Your ActiveX Settings Are Locked Down 
 
The Conference Place console does not require that your ActiveX settings are enabled to 
install or run.  However, if you have Download Signed ActiveX controls and\or Initialize 
and Script ActiveX controls marked as Safe disabled, you see the will see an interim 
Meeting Entry page. At the Meeting Entry page, click the Join Conference Place link. 

JOINING THE INTERCALL AUDIO CONFERENCE 

Conference Place meetings will include a phone conference in addition to the content that 
is being displayed or shared in the web meeting console. With Conference Place, you 
can: 
 

 Join the conference manually by calling the conference call number provided in 
your e-mail invitation. 

 
 If integrated audio is set up, you can have Conference Place call you and 
automatically join the phone conference. 

JOINING AN INTERCALL AUDIO CONFERENCE BY CALLING THE 
CONFERENCE CALL NUMBER 

If the meeting organizer has set up a phone conference for the meeting, the phone 
conference information, including the conference call number and the participant 
passcode, are included in the meeting invitation.  Conference Place displays the 
Conference Call information by default. 
 
To join a conference call 
 

1 Using your phone, call the Audio Conferencing number provided in the 
Conference Place e-mail invitation, and then supply the conference code when 
prompted. 

2 If you are already in the meeting, the following pop-up window will provide you 
with the audio conference information. Using your phone, call the dial-in number 
and supply the participant passcode when prompted. 

JOINING A PHONE CONFERENCE BY HAVING CONFERENCE 
PLACE CALL YOU 

If integrated audio is set up for the meeting, you should see the following dialog when you 
first enter the meeting. If this is the case, enter your phone number in the dialog box. 
Conference Place will then call you and automatically join you to the phone conference. 
The advantage of this method is that you don’t have to remember conference call 
numbers or passcodes -- supply your phone number and Conference Place does the rest. 



  

 

 
 
To have Conference Place call you and join you to the conference call 
 

1 Join the meeting using the steps described earlier in this topic. 
2 In the Audio and Recording Setup dialog box, in the Call me at text box, enter 

your phone number (or the number you want the service to call you at). 
3 Click Join Conference. The Conference Place integrated audio will call the phone 

number you specified. When you pick up the phone, the Conference Calling 
service will have already added you to the Conference Call. The service will ask 
your name so it can announce your arrival to the meeting. 

 
What to do if you experience problems joining the conference call 
 
In some cases, you will experience problems connecting to a conference call, perhaps 
because a wrong number is supplied in the invitation or because the information is simply 
missing. A good way to resolve conference call problems at meeting time is to join the 
meeting and then use the Chat feature in the Conference Place Console to communicate 
with the meeting organizer. 

Getting Started Quickly 

START A MEET NOW MEETING 

Meet Now meetings are a useful alternative to traditional scheduled Conference Place 
sessions. With Meet Now, you create a "virtual office" to which you can invite meeting 
partipants at a moment's notice, for example, to present information, to collaborate on 
documents, or to share an application from your computer. 



  

You can start a Meet Now meeting from Microsoft Office Outlook, if you have installed the 
Microsoft Office Live Meeting Add-in for Outlook, or by using the Conference Place 
Meeting Manager. 
 
Before you start using Meet Now, make sure that your Conference Place account and 
your Meet Now options are set up. For more information about setting up Conference 
Place, see How To Set Up Conference Place. For more information about Meet Now 
options, see How to Set Meeting Options. 
 
To start a Meet Now meeting by using Outlook 
 

1 On the Conference Place Add-in toolbar in Outlook, click Meet Now. Conference 
Place creates an e-mail invitation that you can send to the meeting participants. 

2 In the To box, type your full e-mail address (for example, 
somebody@microsoft.com). 

3 Click Send to send the invitation. Conference Place will display the Meeting Entry 
page. 

4 On the Meeting Entry page, type your name in the field provided, and then click 
Join Meeting. 

5 Conference Place displays the Conference Place Console. You are now ready to 
conduct the meeting. 

 

 
 
The meeting is now started, but you are the only participant. You will invite other 
attendees later. 
 
To start a Meet Now meeting by using the Conference Place Manager 
 

1 In your Internet Browser, enter the URL of your Conference Place Conference 
Center. If you do not know the URL of your conference center, contact your 
Conference Place Account Administrator. 

2 From the Login to Conference Place Manager page, type your User ID in the 
User Login field, and then type your password in the Password field. If you do not 



  

know your User ID and password, contact your Conference Place Account 
administrator. 

3 From the My Home page, in the Meet section, click Meet Now. 

WHAT TO EXPECT WHEN YOU START A MEET NOW MEETING 

When you click Send in the Outlook add-in or you click Meet Now in the Conference 
Place Manager, Conference Place will determine if your have the Conference Place 
console and, in so, if it is up to date. If you already have an up-to-date version of the 
Conference Place console installed, Conference Place will start the console for you. If you 
do not have the console already installed, or if Conference Place finds a version that is 
out-of-date, it will display the Meeting Installer page. 
 
If you see this page, click Install the Windows-based Conference Place Console, and then 
click Run.  When the installation is finished, Conference Place will attempt to start the 
meeting console. If the console does not start automatically, follow the instructions on the 
Meeting Entry page to start the console and enter your Meet Now meeting. 
 
The meeting is now started, but you are the only participant. You will invite other 
attendees later. 
 

 
 

START PHONE CONFERENCING 

After the Conference Place console has started, start the phone conferencing for the 
meeting. By default, Conference Place displays the phone conferencing information for 
you. If you do not have a phone conferencing account, contact your Conference Place 
administrator. 
 
To start phone conferencing 



  

 
Using your telephone, dial the phone conferencing number. When you are connected to 
your phone conferencing number, enter your participant code. When you are prompted, 
enter your leader code.  For more information, see How to Join a Conference Place. 

SHARE A DOCUMENT IN THE CONFERENCE PLACE CONSOLE 

With Conference Place, you can share Microsoft Office documents and any other 
printable documents in the meeting console for presentation and collaboration. As an 
example, the following procedure explains how to share an Office document, but the 
procedure for any printable document is the same. For more information about sharing 
documents, see How to Import and Share Content. 
 
To share a document in the Meeting Console 
 

1 On the Online Meeting Share menu, click Share to View. 
2 In the Choose a Document to Share dialog box, choose a Microsoft Office file 

that you want to share (for example, a Microsoft Word document). 
3 Double-click the file name, and then click Continue. Conference Place converts 

the file to Microsoft Office Document Image (MODI) format and then adds it to the 
Conference Place console. 

4 To display the document, in the Resources pane on the left-hand side of the 
console, click the document that you want to share. If the document contains 
multiple parts (for example, if a PowerPoint® presentation contains more than 
one slide), each part is displayed in the Thumbnails pane. 

 

 
 
Now that the document is loaded and the phone conferencing is set up, you are ready to 
invite participants to your meeting. 

INVITE OTHER PARTICIPANTS 

Beginning with Conference Place 2005, you can invite participants from within the Online 
Meeting console. So you can see how meeting invitations work, in this example you will 
invite yourself, but the procedure for inviting others is the same. 
 
To send a meeting invitation from within the Online Meeting console 
 

1 From the Attendees menu in the Meeting Console, click Send E-Mail Invite. 
2 In the Attendee text box, enter your full e-mail address, for example, 

someone@example.com. 
3 In the Subject box, type a subject for the meeting. 



  

4 In the Message box, type “Let us meet about the specification” or any other text 
that you want to send. 

5 Click Send Message, and then click OK. 
 

 
 
Meeting invitations can take several minutes to arrive. 

JOIN THE MEETING AS AN ATTENDEE 

A meeting invitation indicates whether you are invited as an attendee or as a presenter. In 
this example, you are invited as an attendee. 
 
To join a Meet Now meeting from an e-mail invitation 
 

1 In your e-mail program, open the Meet Now invitation. In the message, click Join 
Meeting. 

2 Depending on how your conference center security is configured, you may do 
one of the following: 

- On the Join Meeting page, enter your name as you want it to be displayed in the 
meeting, the Meeting ID for the meeting, and either the Presenter or Attendees 
Key. The key is included in the e-mail invitation. 

- Go directly to the Conference Place console as a meeting participant. 
3 Once the Conference Place console has started, enter the meeting as an 

attendee. Joining a meeting as an attendee starts a separate instance of the 
console on your computer. 

4 You can now practice sharing documents between the two instances of the 
meeting console that you have started. For more information about sharing 
documents and other resources, see How To Conduct a Meeting. 

 



  

Ending A Meeting 
Once a meeting is finished, there are things you can do to help you stay organized and to 
get the most value from the meeting. Use the following checklist to make sure you have 
considered all of your post-meeting options. 

POST-MEETING CHECKLIST 

 
 Was the meeting recorded? 

 
If so, you may want to: 

- Publish the recording. 
- Verify the published recording location. 
- Play the recording. 
- Invite others to play the recording. 
- Delete the recording. 

For more information, see How To Record a Meeting. 
 

 Did the meeting include any resources that you want to save? 
 

If so, you may want to: 
- Retain meeting content for a few extra days so participants can review it. 
- Print the meeting content to a PDF file. 

For more information, see How To Import and Share Content and How To Set Meeting 
Options. 
 

 Did you generate a question log for the meeting? 
 
If so, you may want to: 

- Reuse the meeting invitation and meeting ID so that all content is retained. 
- Upload all content to your Meet Now session so that you can invite others 

whenever you want. 
- Generate a question log. 
- Print the question log. 

For more information, see How To Conduct a Meeting. 
 

 Do you need to schedule a follow-up meeting with the same attendees? 
 
If so, you may want to: 

- Reuse the meeting invitation and meeting ID so that all content is retained. 
- Upload all content to your Meet Now session so that you can invite others 

whenever you want. 
For more information, see How To Schedule a Conference Place and How To Import and 
Share Content. 
 

 End a Meeting 
 
As an organizer, you can exit a meeting in one of two ways: 

- Leave the meeting, but allow other participants to continue. 
- Leave the meeting, and end the meeting for all participants. 

 
To leave a meeting you have organized but allow others to continue 
 
On the File menu, click Exit. 



  

NOTE: Exiting and Ending the session, will also terminate the audio conference. If you want 
the audio to continue, please do the following: Leave web session open until audio discussion 
has concluded. If you must leave the web session running, have a co-presenter end the 
session so you are not billed for unused minutes. The “please close the door when you leave” 
concept. 
 
To leave a meeting and end the meeting for all participants 

 On the File menu, click Exit and End Session. 

Setting Up Reservationless-Plus Integrated Audio for 
Conference Place 

SET UP AND TEST MEET NOW AUDIO 

You can use the information about your phone conferencing account to set up Meet Now 
audio. You must set up and verify your audio options in order to use Meet Now audio. 
 
To set up/verify Meet Now audio 
 

1 For integrated audio controls, use your InterCall Reservationless-Plus Dial-In 
number, conference code, and leader PIN to log on to Conference Place. 

2 On the My Home page, click Meet Now Details. 
3 On the Meet Now Details page, click Meet Now Options. 
4 On the Meet Now Options page, click Audio. 
5 In the This meeting uses list, click Conference Place with audio conferencing. 
6 In the Conferencing provider list, select InterCall: 
7 Select the phone conferencing options you want to enable. 

- Allow meeting participants to use the Join Conference option (for InterCall 
Reservationless-Plus audio only). When this option is enabled, meeting 
participants can click Join Conference in the Conference Place console to have 
the conferencing service call their phone, rather than dialing in to the conference 
call. 

- Display the Toll-free phone number to. Select this option to display the toll-free 
number you are using in the Audio dialog box or in the Meeting Information 
dialog box for all attendees to see. 

- Display the Toll phone number to meeting. Select this option to display the toll 
number you are using in the Audio dialog box or Meeting Information dialog box 
for all attendees to see. 

8 Enter the correct toll and toll-free phone numbers for your Reservationless-Plus 
account account. 

9 Enter the conference code and the leader PIN assigned to you for your phone 
conferencing account. 

10 Click OK. 
 
 



  

 
 
To test Meet Now audio 
 

1 On the Meet Menu, click Meet Now to start the Online Conference Place console 
with you as a presenter in your own Meet Now meeting. 

2 Do one of the following: 
- If you selected InterCall (not Other), you can test the phone conferencing 

features in the Conference Place console. On the Audio menu, click Join 
Conference, expand the Join Conference section, and then enter the phone 
number where you want to be called. Click Join Conference. Within a few 
seconds, you should receive a call. When you answer the call, you will be joined 
to the phone conference for the meeting. 

SET UP AND TEST THE DEFAULT AUDIO FOR SCHEDULED 
MEETINGS 

You can configure default audio settings that are used whenever you schedule a meeting. 
This section explains how to do so and also how to test the settings that you specify. 
 
NOTE: The procedure in this section for setting up the default audio for scheduled meetings 
affects all meetings you schedule with Conference Place. You can override the default settings 
for a specific meeting by clicking the meeting name (instead of Schedule Meeting) in step 1 in 
this procedure, and then clicking Save (instead of 
Save as Default) in step 10. 
 
To set up the default audio for scheduled meetings 
 

1 On the My Home page, under Meet, click Schedule Meeting. 
2 Click Meeting Options. 
3 On the Meeting Options page, click Audio. 
4 On the Meeting Options page, click Audio. 
5 In the This meeting uses list, click Conference Place with audio conferencing. 
6 In the Conferencing provider list, select InterCall. 
7 Select the phone conferencing options you want to enable. 



  

- Allow meeting participants to use the Join Conference option (for InterCall 
Reservationless-Plus audio only). When this option is enabled, meeting 
participants can click Join Conference in the Online Conference Place console to 
have the conferencing service call their phone, rather than dialing in to the 
conference call. 

- Display the Toll-free phone number to. Select this option to display the toll-free 
number you are using in the Audio dialog box or in the Meeting Information 
dialog box for all attendees to see. 

- Display the Toll phone number to meeting. Select this option to display the toll 
number you are using in the Audio dialog box or Meeting Information dialog box 
for all attendees to see. 

8 Enter the correct toll and toll-free phone numbers for your phone conferencing 
account. 

9 Enter the participant code and the leader pin assigned to you for your 
Reservationless – Plus account. 

10 Click OK. 
11 Select Set as Default if desired. 

 

 
 
 
To test audio for scheduled meetings 
 

1 On the My Home page, under Meet, click Schedule Meeting. 
2 Enter your e-mail address in the Attendees and Presenter boxes. 
3 In the Start box, select the current time. In the End box, select an appropriate 

time to end the test meeting. 
4 Click Send Invitations to send the invitation to yourself. 
5 In your e-mail client inbox, wait a few minutes for the invitation to arrive, and then 

open the invitation. 
6 In the invitation, verify that the audio conferencing information is correct, 

including the audio conferencing number and the participant passcode. 
7 To join the meeting, click Join Meeting in the e-mail message. 
8 Do one of the following: 



  

- If you selected InterCall (not Other), you can test the phone conferencing 
features in the Conference Place console. On the Audio menu, click Join 
Conference, expand the Join Conference section, and then enter the phone 
number where you want to be called. Click Join Conference. Within a few 
minutes, you should receive a call. When you answer the call, you will be joined 
to the phone conference for the meeting. 

Conduct Your Meeting 
If you are a meeting organizer, Conference Place provides a number of tools that can 
help you run a more effective meeting. This topic explains some ways that you can help 
all participants to get the most out of your meeting. 

GETTING STARTED 

Before conducting a meeting, make sure that you have done the following: 
 

 Set all options for your meeting, including audio and meeting lobby settings. For 
more information, see How To Set Meeting Options. 
 Conducted a test meeting to verify that your settings are correct. For more 
information, see How to Get Started Quickly. 
 Sent invitations for the meeting containing the correct meeting information. For 
more information, see How To Set Meeting Options and How To Schedule a 
Conference Place. 
 Imported any content that you will present at the meeting. For more information, 
see How To Import and Share Content. 

CONFIGURE THE CONFERENCE PLACE MEETING CONSOLE 

The Conference Place Online Meeting Console is made up of multiple panes. You can 
view or hide panes for any meeting. Many panes have buttons that you use to perform 
tasks. For example, the Now Presenting pane provides a button to lock control for content 
display.  
 



  

 
 
As the organizer of a meeting, you can control which panes you want to enable or disable 
for other participants at your meeting. For more information, see “How To: Set Meeting 
Options.” 
 
To hide and show panes in the Conference Place meeting console 
 

 On the View menu, point to Panes, and then click the pane that you want to show 
or hide. A check mark indicates that a pane is currently shown. 

INTERACT WITH ATTENDEES AND MANAGE PARTICIPATION 

The Attendees pane lists participants' names, their ”mood,” whether chat with them is 
blocked, and whether they are a presenter or attendee. You can search for a participant, 
or you can sort the list that appears. 
 
To see who is attending your meeting 
 

1 If the Attendees pane does not already appear in your meeting console, on the 
View menu, click Panes, and then click Attendees. 

2 To sort the list of participants, select an option in the Arrange by list. For 
example, to sort\ alphabetically by participant name, click Name in the Arrange 
by list. 

3 To find an attendee, in the Search list for person box, type the first few letters or 
the name of the person you want to locate. As you type, the Attendees pane 
updates the list to match your criteria. The more characters of the person's name 
that you enter, the more precise the match. 

 



  

 
 
 
To make an attendee a presenter 
 

1 In the Attendees pane, click the name of the attendee you want to make a 
presenter. 

2 Click the right arrow next to the attendee's mood color. 
3 In the attendee's information box, click the right arrow, and then click Make a 

Presenter. 
 
 



  

 
 
To invite more people to your meeting 
 

1 In the Attendee pane, click Send E-mail Invite. 
2 In the Attendees box of the Send E-mail Invite dialog box, type the full e-mail 

addresses for all those invited as attendees, separated by semicolons. In the  
box, type the full e-mail addresses of all those invited as presenters, separated 
by semicolons. 

3 Type a message, if you wish, and then click Send message. 

MANAGE AND RESPOND TO QUESTIONS 

Presenters can use the Question Manager to review and respond to attendee questions. 
The Question 3Manager identifies each question by the person who asked it and the time 
it was posted. The check box in the Marked column indicates if the question was selected 
and marked for the next action you take. You can also view and save a log of question 
and answer activity from your meeting. 
 
Use the Question Manager to view questions from participants and to provide your 
responses. Attendees can send questions to any presenter, and the presenter can 
respond either privately or with an answer that appears to all attendees. 
 
NOTE: The Questions and Answers pane is available only if the presenter allows attendees to 
ask questions. 
 
To enable questions for a meeting 
 

1 In the Attendees menu, click Attendee Permissions. 
2 In the Attendee Permissions dialog box, select the Ask Questions check box. The  
3 Questions and Answers pane will appear in the Conference Place console. 

 
To display or hide the Questions and Answers pane 



  

 In the View menu, point to Panes, and then click Questions and Answers. If a 
check mark appears beside the menu item, the pane is shown. If not, the pane is 
hidden. 

 
To display the Question Manager 
 

 In the Questions and Answers pane, click Question Manager. The Question 
Manager appears, listing all questions received from attendees. 

 
To respond to a question, a presenter can do the following: 
 

 Answer the question either by sending a text response to all of the attendees or by 
sending a private text message to an individual attendee. 
 Initiate a 1-on-1 chat with the questioner to discuss the issue. 
 Not respond at the current time. 
 Dismiss the question. 
 Allow the questioner to address the entire audience by taking the floor. 

 

 
 
NOTE: If multiple presenters are working together to monitor questions, each presenter's 
actions in the Question Manager are automatically reflected in the all presenters' Question 
Managers. For example, if one presenter dismisses a question, it is also removed from the 
other presenters' Question Managers. 
 
To respond to a question from an attendee 
 

1 If the Question Manager is not visible, display it as explained earlier in this topic. 
You can sort the list of questions by whether the question is marked, whether the 
person asking the question has the floor, alphabetically by either the asker's 
name or the text of the question, or by the time the question was posted. To do 
so, click the appropriate column heading. Click the column heading again to 
toggle between an ascending and descending sort. 



  

2 In the Question Manager, click the question that you want to answer, and then do 
one of the following: 

 
• To give the asker the floor, click Give the Floor. 
• To chat one-on-one with the asker, click Chat 1:1. 
• To answer the question publicly, in the Your Answer box, enter your 

response, and then click Post to All. 
• To answer the question privately, in the Your Answer box, enter your 

response, and then click Post Privately. 
 
NOTE: As a Presenter, you can always see who asked each question. When you choose the 
Post to All option, the question appears anonymously to all participants. 
 
To ask a question 
 

1 In the Questions and Answers pane, type your question in the one-line box at the 
bottom of the pane, and then click Ask. 

2 After asking a question, you can also do the following: 
• Edit the question. Click Edit, make your changes, and then click Ask. 
• Delete the question. Click Edit, and then click Delete. 

 
To view and save a question log for your meeting 
 

1 In Question Manager, click View Log. All of the question and answer activity from 
your meeting will be displayed in a separate browser window. 

2 To save the question log, use your browser to save the HTML page containing 
the log, or open a text editor, paste the contents of the log to a new file, and then 
save the file. 

CHAT WITH ATTENDEES 

Chats are a useful way for presenters to communicate with attendees or presenters 
during a meeting, such as when a presenter suggests a break-out session to discuss a 
specific issue with another attendee. 
 
In some circumstances, you might also want to allow attendees to open text chats with 
one another.  Participants can then conduct brief, separate conversations away from the 
larger group. When chatting is enabled, each participant can have multiple one-on-one 
chat sessions open simultaneously. Any participant can block individual participants from 
chatting with them by clicking the name of the participant in the Attendees pane and then 
clicking Block at the bottom of the pane. 
 
As a presenter, your can always chat with meeting participants.  But you can control 
whether participants can chat among themselves. 
 
To control attendees chatting with each other 
 

1 On the Attendees menu, click Attendee Permissions. 
2 In the Attendee Permissions dialog box, if the Interact check box is cleared, 

select it. If the box has a check mark or a green rectangle, select Chat with other 
attendees. 

3 If you selected the Interact check box, verify that the settings for the other 
interaction options are as you want them, and change them as necessary. 

4 Close the Attendee Permissions dialog box. 



  

To chat with another attendee 
 

1 In the Attendees pane, click the name of the person with whom you want to chat. 
2 Click the right arrow located to the right of the person's mood color. 
3 In the person's information box, click the right arrow, and then click Chat. A Chat 

box appears on both your computer and the person's computer with whom you 
select to chat. The person's name appears in the title. 

4 Enter your comment or question in the box, and then click Send. The chat 
between you and the other attendee appears at the top of the box. Your chat is 
private and cannot be seen by other attendees. 

5 When you finish chatting, close Chat. 
 

 
 

MANAGE UNINVITED ATTENDEES 

The meeting lobby is a place where people without an invitation can attempt to join a 
meeting. It is similar to reservationless audio conferencing, in which attendees can 
attempt to join a meeting at anytime regardless of invitation status. Attendees who join a 
meeting by using the meeting lobby use a different URL than the one that is included in 
Conference Place meeting invitations. 
 
Organizers can use the meeting lobby to schedule meetings without sending invitations to 
attendees. Meetings are simply set and joined by attendees who enter the Meeting Lobby 
and wait for the meeting owner to grant them access. As an organizer, you can request 
that Conference Place send you an e-mail notification whenever an attendee arrives in 
your meeting lobby. You can then selectively grant or deny access to each attendee in the 
Meeting Lobby. If you do not respond within 30 minutes, the attendee is denied access. 
Similarly, Conference Place can send you an e-mail notification when new attendees join 
the meeting while a meeting is in progress. You can also "lock the door" to prevent such 
interruptions. 
 
A common use of the meeting lobby is to provide people with spontaneous access to your 
Meet Now meeting area at a time that they choose, rather than waiting to receive an 
invitation from you. For example, you can include the meeting lobby URL for your Meet 



  

Now meeting area on your business cards and e-mail signatures. Customers or co-
workers who want to request an impromptu meeting with you can visit that URL in their 
browser, and then wait up to 30 minutes for you to receive an e-mail notification and join 
them in the meeting. 
 
You configure the meeting lobby when you set the meeting options for a Meet Now 
meeting or a scheduled meeting. 
 
To control meeting access through the meeting lobby 
 

1 In the Attendees menu, click Meeting Lobby. 
2 In the Meeting Lobby window, select attendees to whom you want to grant 

access, and then click Grant Access. 
3 In the Meeting Lobby window, select attendees to whom you want to deny 

access, and then click Deny Access. 
 

 
 
 
Monitor Attendees 
 
The Seating Chart pane provides a view of the number of attendees and their ongoing 
feedback. Each participant in the meeting is represented by a colored rectangle, the color 
of which indicates the participant's current perception of the meeting. This perception is 
referred to as the participant's mood. 
 
Depending on the number of attendees, the configuration of the seating chart changes.  A 
large meeting is represented by a row of presenters and many rows of attendees. A 
smaller meeting is represented by a round table surrounded by several participants 
surrounding it. 
 



  

Seating charts can help you gather rapid feedback from your audience as participants 
change their chart colors to indicate their responses throughout the meeting. 
 
One use of the Seating Chart is to allow participants to respond to information you 
request during your presentation. For example, you might start your meeting by having 
everyone change their seat color to “Yellow” if they can hear your voice and are ready to 
begin. This gives you a visual representation that your audience can hear you and is 
paying attention. It also gets them using the Conference Place user interface, which 
keeps them engaged. 
 
You can use the colors of the attendee icons to: 
 

 Check on the pace of your presentation 
 Get a quick "snapshot" of your audience 
 Let attendees tell you they have a question or concern 
 Indicate when an attendee temporarily steps away from the meeting 

 
You might want to change the seating chart legend for a meeting, so that attendees 
understand what each color means. By default, the colors in the seating chart include the 
following descriptions: 
 

 Red: Slow down 
 

 Blue: Speed up 
 

 Yellow: Need help 
 

 Green: Proceed (this color is shown by default 
for all attendees) 

 
 Purple: Question 

 
 

 
To view the seating chart for your meeting 
 

 In the View menu, point to Panes, and then click Seating Chart. 
 
To edit the seating chart legend for your meeting 
 

1 In the Attendees menu, click Attendee Permissions. 
2 In the Attendee Permissions dialog box, click the See the Seating Chart option. 

USE ANNOTATIONS 

You can allow attendees and other presenters to attach annotations to resources during 
your meeting. If you imported the resource, all annotations stay in Conference Place, they 
do not affect the original document or presentation. 
 
To allow attendees to interact and edit documents within a presentation 
 

1 From the Attendees menu, select Attendee Permissions. 
2 Under Allow Attendees to, select Annotate/Edit current page/slide. 
3 Close the Attendee Permissions window. 



  

 

 
 

Importing and Sharing Content 
Content provides the visual component of the meeting for all participants. Online content 
is basis for allowing participants to view, express, and share ideas. As presenter, you can 
share content in four different ways: 
 

 Import and display a PowerPoint slide presentation 
 Import and display other document types 
 Display the use of applications that are running on your computer 
 Work with Conference Place collaborative slides (Whiteboard, Web, Text, Poll, and 
Snapshot) 

 
Once you have shared content with others at the meeting, you can collaborate in the 
following ways: 
 

 Use all functions of PowerPoint to work with slides in a presentation 
 Mark up other document types using annotations 
 Allow other presenters to share control of applications that are running on your 
computer 
 Work together on Conference Place collaborative slides (for example, add 
Annotations) 

SHARE CONTENT 

Use the scenarios in this section to get started quickly with some common methods of 
importing and sharing Conference Place content. 
 
To present slides 
 
This scenario assumes that you have created a PowerPoint slide presentation that you 
want to present at the meeting. 
 

1 In the Share menu, click Share Document to View. 
2 Navigate to the presentation you want to display, and then click Open. 



  

Conference Place copies the file to the Conference Place service, and then adds it as a 
resource to the Resources pane in the Conference Place console. You can now present 
the slides. 
 
To collaborate on a Word document 
 
This scenario assumes that you want to share a Word document with other attendees at a 
meeting, and show them the changes you are making to the document as your discussion 
ensues. 
 

1 In the Share menu, click Share Document to Edit. 
2 Navigate to the Word file you want to display, and then click Open. 

 
The file appears on your desktop and is visible to all attendees, with the sharing controls 
along the left side of your screen. You can now make changes to the document, and 
others will see the changes in real time. 
 

 
 
To lead a group review of a read-only file 
 
This scenario assumes that you will share a file (other than slides) that you want all 
attendees to see, but you will not collaborate on making changes—although you can use 
annotations to mark up the file within Conference Place. 
 

1 In the Share menu, click Share Document to View. 
2 Navigate to the file you want to display, and then click Open. 

 
Conference Place copies the file to the Conference Place service, and adds it as a 
resource to the Resources pane in the Conference Place console. You can now discuss 
the file, and attendees can make annotations (if permitted). 
 
 



  

To lead a brainstorming session using a Whiteboard slide 
 
This scenario assumes that you and the other attendees will draw/write together on a 
Whiteboard slide in order to brainstorm your ideas for a project. 
 
In the Share menu, click Whiteboard. 
 

 
 

IMPORT CONTENT 

If you want to display content created outside of Conference Place (that is, not a 
collaborative slide) you must first import the content as a resource in the Conference 
Place meeting console. Importing is most commonly used to add slide presentations. 
 
Note: Resources that you import stay in the meeting until you remove them. If you import 
content during a Meet Now meeting that you have organized, the content will remain there for 
all of your future Meet Now meetings until you remove it. 
 
As you present content, you can change your display to Full Screen view to make the 
presentation larger and easier for attendees to see. 
 
To import content to the Conference Place meeting console 
 

1 In the Share menu, click Share Document to View. 
2 Navigate to the file you want to import, and then click Open. 

 
Conference Place copies the file to the Conference Place service, and adds it as a 
resource to the Resources pane in the Conference Place console. 
 
To change your display from Console view to Full Screen view 
 



  

1 In the View menu, click Full Screen Mode. 
2 To return to Console view, press ESC. 

 

 
 

NAVIGATE CONTENT 

You and other presenters manage Conference Place content using the Resources pane 
in the meeting console. The Resources pane displays all content that you and the other 
presenters have made available for sharing at the meeting. To share content, you must 
first add the content to the Resources pane, either by importing it or by creating a new 
Conference Place collaborative slide. 
 
After you have added content to the Resources pane, you can click the resource in the 
Resource pane to display it in active content pane. If a resource contains multiple parts 
(for example, a slide presentation) you can view the parts by clicking the resource and 
viewing the Thumbnails pane. Within the thumbnails pane, you can right-click any 
thumbnail image to perform the following actions: 
 

 Insert a collaborative slide before the thumbnail image 
 Perform PowerPoint functions (if the resource is a presentation) 

 
To view the Resources pane: 

 In the View menu, point to Panes and click Resources. 
 
To view the Thumbnail pane for a resource: 
 

1 In the Resources pane, click the resource whose thumbnails you want to view. 
2 In the View menu, click Show Thumbnails. 

SHARE THE USE OF YOUR COMPUTER 

 



  

Besides uploading content in Conference Place, you can share the use of your computer 
as part of presenting during a Conference Place session. 
 
Sharing the use of your computer can take several forms. The simplest way to share is to 
open a document on your computer and make changes to the file while displaying it to the 
other attendees. Or, if you want to show multiple processes on your computer involving 
more than one application, you can share your entire desktop. 
 
For either of these options, you can also share control (over the application or over the 
desktop) with one other presenter at the meeting. While you are sharing control, the other 
presenter has access to all of the same abilities that you have on your computer. At any 
point, you can end application sharing control, and the ability of the other presenter to 
control your computer is blocked. 
 
To open and display a file from your computer: 
 

1 In the Share menu, click Share Document to Edit. 
2 Navigate to the file you want to display, and click Open. 

 
The file appears on your desktop and is visible to all attendees, with the sharing controls 
along the left side of your screen. 
 
To display an application that is installed on your computer: 
 

1 Start the application that you want to display to attendees. 
2 In the Share menu, click Share Application. 
3 In the Sharing dialog box, click the name of the application you want to display. 
4 Click OK. 

 
The application you shared is now visible to all attendees, with the sharing controls along 
the left side of your screen. 
 
To display the sharing frame: 
 

1 In the Share menu, click Share Application. 
2 In the Sharing dialog box, click The Sharing Frame. 
3 Click OK. The Sharing Frame appears on your desktop. 
4 Resize the Sharing Frame as needed for the contents of your desktop that you 

want to display to attendees. 
 
The portion of your desktop inside the Sharing Frame is now visible to all attendees, with 
the sharing controls along the left side of your screen. 
 
To display your desktop: 
 

1 In the Share menu, click Share Application. 
2 In the Sharing dialog box, click Desktop. 
3 Click OK. 

 
Your desktop is now visible to all attendees, with the sharing controls along the left side of 
your screen. 
 
To share control of your computer with another presenter: 
 



  

1 In the Sharing controls, click the Share Control button. 
2 In the Give Control dialog box, click the name of attendee to whom you want to 

give control, and then click OK. 
 
The controlling participant can now use the selected items on your computer. For 
example, if you give control of Microsoft Word, all participants see the controller's use of 
the Word document you are sharing. 
 
To end application sharing control: 
 

 On the Sharing controls, click the Take Control button. 

USE COLLABORATIVE SLIDES 

Collaborative slides are Conference Place slides that help you collaborate with other 
attendee’s Unlike PowerPoint presentations, collaborative slides do not need to be 
imported or created in advance. You can insert collaborative slides spontaneously during 
a meeting, to help capture a certain idea or brainstorm with other attendees. 
 
The following five collaborative slide types are available: 
 

 Whiteboard slide - A Whiteboard slide is a blank image slide upon which you can 
draw, add text and stamps, and highlight information, by using the Annotation tools. 
For example, if you want to quickly create a flow chart to illustrate a point, insert a 
White Board slide and then use the Annotation tools to draw squares, lines, and so 
on. 
 Web slide - A Web slide lets you display a Web page to the attendees and provides 
each attendee with an independent connection to that URL, allowing them to 
navigate the site freely. Web slides are ideal for allowing attendees to complete a 
survey or form during your meeting. Web slides are also great for incorporating 
video or flash files into your meeting. 
 Text slide - A Text slide is a blank editable text slide upon which you can type. For 
example, if you want to type new information that is available to the audience to 
copy and paste, such as an action items list, you can create a Text slide. When you 
create and work with a Text slide, you can use the Edit menu commands to copy, 
paste, cut, and delete text. 
 Polling slide - Use polling slides to find out attendees' reactions and opinions during 
a presentation.  Polling slides are a great way to solicit feedback from attendees by 
allowing them to select from several responses to a question. You can create 
Polling slides ahead of time or insert them on-the-fly during your presentation. 
 Snapshot slide - A Snapshot slide shows a captured screen shot from your 
computer, such as a captured spreadsheet or graphic. After you create a Snapshot, 
you can use the Annotation tools to add annotations to it. 
 Typically, you will add collaborative slides as new resources. However, you may 
choose to insert a collaborative slide into an existing resource—for example, as a 
new slide in a PowerPoint presentation resource that you previously imported. 

 
To add a collaborative slide as a new resource: 
 

 In the Share menu, click the type of slide you want to add: Whiteboard, Web, Text, 
Polling, or Snapshot. 

 
 



  

The slide is added as a new resource in the Resources pane, and you can begin using it 
to collaborate with the other attendees. 
 
To insert a collaborative slide into an existing resource: 
 

1 In the Resources pane, click the resource into which you want to add a 
collaborative slide. 

2 In the Thumbnails pane, right-click the thumbnail directly above the point where 
you want to insert the slide. Point to Insert New Slide, and then click the type of 
slide you want to add: Whiteboard, Web, Text, Polling, or Snapshot. 

 
The slide is added at the insertion point you specified in the existing resource. 

Schedule a Meeting 
You can use Conference Place to schedule meetings and invite participants, just as you 
would for a meeting in a physical conference room. This topic describes how to: 
Schedule a meeting by using Outlook 
 
The easiest way to schedule a meeting is by using Microsoft Office Outlook. To use 
Outlook to schedule meetings in Conference Place, you must install the Conference Place 
Add-In for Outlook. With the add-in, you can use Outlook calendar features to schedule 
meetings so that you can determine if users in your address book are free or busy for a 
meeting time. You can also look up e-mail addresses in your address book when sending 
invitations. 
 

 
 
 
To schedule a meeting using Outlook 
 

1 On the Conference Place toolbar in Outlook, click Schedule Conference Place. 
2 Select an appropriate start time in the Start time box and an appropriate end time 

in the End time box. 



  

3 In the To field, enter the participants you want to invite, either by clicking To to 
look up each participant in your address book or by typing each participant's full 
e-mail address (for example, somebody@intercall.com), separated by 
semicolons. 

4 In the Subject box, type a subject for the meeting. 
5 If you want, in the message area, type a message to the people you are inviting. 

This message will be added at the beginning of the standard Conference Place 
invitation text. 

6 Click Send. 
 

 
 
Allow several minutes for the meeting invitations to arrive in the inbox of each invitee. 
Conference Place sends a separate meeting invitation to each of the presenters and 
attendees you invited. The invitation contains your personal message if you provided one, 
the standard Conference Place greeting text set by your Conference Place account 
administrator, and the meeting details that each participant will need in order to join the 
meeting. Invitees also receive a calendar item that they can directly add to their 
calendars. 
 
Accept the meeting invitation and join the meeting 
 
When the scheduled meeting invitation arrives, click Accept to accept the invitation so it is 
stored in your calendar. When it is time to join the meeting, open the meeting entry in your 
Outlook calendar, and then click Join Meeting. 

SCHEDULE A MEETING BY USING THE CONFERENCE PLACE 
MEETING MANAGER 

 
If you do not use the Conference Place Add-In for Outlook, you can schedule meetings by 
using the Conference Place Meeting Manager. 
 
To schedule a meeting with the Conference Place Manager 
 

1 On the My Home page, in the Meet area, click Schedule Meeting. 
2 Click Attendees to select the attendees you want to invite from the Conference 

Place address book, and then click Presenters to select the presenters you want 
to invite. For participants who do not appear in the address book, you can type 



  

each user’s full e-mail address (for example, someone@example.com) in the 
Attendees or Presenters box. 

3 Select the start and end dates and times. 
4 In the Occurrence box, click One Time (occurs once only), Recurring (occurs on 

a regular schedule with a specified end date), or Ongoing (no end date 
enforced). 

5 To override the default scheduled meeting options for this meeting only, click 
Meeting Options, and then make the necessary changes. For more information, 
see How to Set Meeting Options. 

6 In the Message text box, type the custom message that you want to appear in the 
invitation. 

7 Click Send Invitations to send the invitations to the invitees. 
 

 
Allow several minutes for the meeting invitations to arrive in the Inbox of each invitee. 
Conference Place sends a separate meeting invitation to each of the presenters and 
attendees you invited. The invitation contains your personal message if you provided one, 
the standard Conference Place greeting text set by your Conference Place account 
administrator, and the meeting details that each participant will need in order to join the 
meeting. Invitees also receive a calendar item that they can add to their calendars. 

SCHEDULE AND JOIN A TEST MEETING 

 
To become more familiar with the Conference Place scheduling process, as well as to test 
the default options you have set for scheduled meetings, you can schedule a test meeting 
with yourself. This test procedure can help you understand Conference Place scheduling 
behavior before you invite a large group of people to your first scheduled meeting. For 
more information about setting options for scheduled meetings, see How to Set Meeting 
Options. 
 
To schedule a test meeting using Outlook 
 

1 Start Outlook. 
2 On the Conference Place toolbar, click Schedule Conference Place. 
3 Schedule the meeting for the current time by using the Start time and End time 

list boxes. 
4 In the To field, type your full e-mail address (for example, 

somebody@microsoft.com). This will instruct Conference Place to send you an 
invitation to the meeting. 

5 Optionally, in the Subject box, type a subject for the meeting (for example, "Test 
Meeting"). 

6 Optionally, in the message area, type a message to the people you are inviting 
(for example, "Test Message"). This message will be added at the beginning of 
the standard Conference Place invitation text. 

7 Click Send. 



  

NOTE: The meeting invitation may take several minutes to arrive in your Inbox. 
 
When the meeting invitation arrives, open the invitation, and make sure that it contains 
the expected information. If you are using phone conferencing for your meetings, make 
sure that your invitation has the correct phone conferencing number and participant code. 
If any information is wrong or missing, click Schedule Conference Place in Outlook, click 
Meeting Options, correct the settings as necessary, and then click Save As Default. Then 
schedule a new test meeting. 
 
To join the meeting that you have scheduled 
 

1 Open the e-mail invitation for the meeting. 
2 In the meeting invitation, click the Join Meeting link. 
3 On the Join Meeting page, enter your name, and then click Join Meeting. 
4 Conference Place starts the Conference Place Console, and your scheduled 

meeting is displayed. 

Setting Meeting Options 
You can customize the Conference Place experience by setting options for individual 
meetings. For example, you can control how meeting participants will enter a meeting, or 
you can enable or disable features such as chatting or recording. 
 
 

 

SET MEETING OPTIONS 

You set options separately for Meet Now meetings and for scheduled meetings. 
 
To set Meet Now options 
 

 On the My Home page, click Meet Now Details, and then click Meet Now Options. 
 To set a specific option, click the appropriate link at the top of the Meet Now 
Options page. For details about specific options, see Meeting Options later in this 
article. 



  

 When you have finished setting options, click OK. The options that you set will 
apply to all future Meet Now meetings. 

 
To set options for a scheduled meeting 
 
To begin setting Meeting Options, do one of the following: 
 

 If you are setting options for a new meeting, in the My Home page, under Meet, 
click Schedule Meeting. 
 If you are setting options for an existing meeting, in the My Home page, click the 
meeting for which you want to set options. 

 
Click Meeting Options. 
 

 To set a specific option, click the appropriate link at the top of the Meeting Options 
page. For details about specific options, see Meeting Options later in this article. 
 When you have finished setting options, if you want to set these options as the 
default settings for all future scheduled meetings, click Set As Default. 
 Click OK. 

MEETING OPTIONS 

The following table shows the options that appear on the Meeting Options page. For a 
detailed explanation, click the option you want to know about. 
 
MEETING DETAILS EXTENDED REGISTRATION CONTENT EXPIRATION 

Entry Control Meeting Lobby Audio 

Meeting Entry Time Additional Features Recording 

MEETING DETAILS 

 You are configuring Conference Place for the first time after it was installed. 
 You want to change the length of your Meet Now sessions. 
 You want to expand a meeting to include more people, and you need more 
simultaneous connections to the Conference Place service. 

 
To set meeting details 
 
In the Meeting Details section of either the Meet Now Options page or the Meeting 
Options page, set the following options: 
 

 (Scheduled Meetings only) In the Meeting ID text box, type the ID for the meeting. 
 (Scheduled Meetings only) In the Type section, click Web Meeting Place for 
collaborative meetings or for smaller groups so that participants can share control 
of the meeting, or click Auditorium Place for formal presentations or meetings with 
larger audiences, where the presenter is in control, presents the slides, monitors 
the audience, and obtains feedback. 
 In the Language list, click the language in which you want the Conference Place 
console to appear. The language options also specifies the language of meeting 



  

invitations, as well as the language used for descriptive data for Conference Place 
recordings. 
 In the Meeting Size box, enter the maximum number of people that you expect to 
attend a meeting. 

 
NOTE: meeting size is capped 
 

 (Meet Now only) In the Meeting Duration list, select the maximum length of the 
meeting. 

ENTRY CONTROL OPTIONS 

You can set entry controls to: 
 

 Control who attends a meeting. 
 Make a meeting available for a large general audience. 
 Distinguish between participants who are attendees and those who are presenters. 

 
To set entry control options 
 

 In the Entry Control, Presenters section of either the Meet Now Options page or the 
Meeting Options page, set the following options: 
- To limit attendance as a presenter to individuals who have a meeting key (a 

password), whether supplied by you or generated by Conference Place, click 
Meeting Key. 

- In the Entry Control, Attendees section of either the Meet Now Options page or 
the Meeting Options page, set the following options: 

- To limit attendance as an attendee to individuals who have a meeting key (a 
password), whether supplied by you or generated by Conference Place, click 
Meeting Key. 

- To allow anyone to join a meeting, whether or not they have a meeting key or a 
membership in your Conference Place conference center, click Free Entry. Keep 
in mind that anyone may enter as either a presenter or an attendee. 

MEETING ENTRY TIME 

You can prevent attendees from joining a Meet Now meeting before you are ready. 
Presenters can always join the meeting at any time. 
 
To set meeting entry time options 
In the Meeting Entry Time section of either the Meet Now Options page or the Meeting 
Options page, select the appropriate option: 
 

 To prevent attendees from joining the meeting until 30 minutes before the 
scheduled meeting time, click Attendees - 30 min, early, Presenters - anytime. To 
allow attendees to join the meeting whenever they want, click Anyone - anytime 

EXTENDED REGISTRATION 

You can require participants to supply their e-mail address and company name when they 
attempt to join a meeting. This requirement is called extended registration. 
 
To set extended registration options 
 



  

In the Extended Registration section of either the Meet Now Options page or the Meeting 
Options page, select the appropriate option: 
 

 To require extended registration, click Request e-mail address and company name. 
To allow participants to join the meeting without supplying their e-mail address and 
company name, click Do not request email address and company name. 

MEETING LOBBY 

The meeting lobby is an area where uninvited people who would like an invitation to your 
meeting can request entry. You can set meeting lobby options for your Meet Now 
meetings or for any scheduled meeting that you organize. You can give users a URL to a 
meeting, such as a Meet Now meeting, when it is not appropriate to send a meeting 
invitation. For example, you can include the meeting lobby URL on your business cards 
so that users can enter an ongoing Meet Now meeting. Presenters can use the meeting 
lobby to control who enters the meeting, as well as the time that they enter. 
 
To set meeting lobby options 
 
In the Meeting Lobby section of either the Meet Now Options page or the Meeting Options 
page, set the following options: 
 

 To enable the meeting lobby for your meeting, click Enable Meeting Lobby for this 
meeting. In the Lobby greeting box, type a message for visitors to the meeting 
lobby. When you enable the meeting lobby, you will see a meeting lobby URL on 
the Meeting Details page for Meet Now meetings. This is the URL that you can 
send to people to allow them access to your meeting if they do not have an 
invitation. 
 If you want Conference Place to send an e-mail notification to you when individuals 
are waiting in the meeting lobby, click Enable e-mail notification from lobby 
attendees. 

ADDITIONAL FEATURES 

The options listed under Additional Features on the Meet Now Options page or the 
Meeting Options page are useful for enhancing participants' meeting experience, for 
limiting what they can do in some circumstances, and for demonstrating features of the 
Conference Place console so that attendees become familiar with them. 
 
To set additional features 
 
In the Additional Features section of either the Meet Now Options page or the Meeting 
Options page, set the following options: 

 
 To allow attendees to ask questions of the presenterse, select the Question and 
Answer Control Panel check box. 
 To allow attendees to use the Conference Place console to end the meeting, select 
the Show End Session Option in Console check box. 
 To allow attendees to use the Conference Place console to send e-mail messages 
to each other, select the Send e-mail to each other check box. 
 To allow attendees to use the Conference Place console to chat with each other 
and with presenters, select the Chat check box. 

 



  

 To allow presenters to share programs with other participants, select the 
Application Sharing check box. 
- To determine the level of control that presenters have over application sharing, 

click Never, When sharing a Single Application only, or When sharing the 
Desktop, Frame, or Single Application, as appropriate. 

- To allow individual participants to request control of a program, select the Allow 
meeting participants to request control check box. 

- To set the color quality of shared applications, which can affect the performance 
of application sharing over the network, click the appropriate option from the How 
many colors to use for sharing list. 

 To allow participants to print meeting content to an Adobe Acrobat file (.pdf), click 
Printing to PDF. To enable printing for all participants or to limit it to presenters 
only, click the appropriate option. 
 To make the seating chart visible to all participants, select the View the seating 
chart check box. You must also select this check box to edit the color-coded legend 
in the seating chart. If you want only to edit the legend, but not make the seating 
chart visible, clear the check box when you are finished editing the legend. 
- To edit the color-coded legend in the seating chart, change the text in the Title 

box and the boxes corresponding to the colors you want to change. 
- To define a color as the default when a participant joins the meeting, click the 

color. 
- To enable a custom pane in the Conference Place console that contains 

streaming media content from a source you specify, select the Streaming Media 
Custom Frame check box. 

- In the Attendee URL box, enter the URL of the source of streaming media 
content for attendees. 

- In the Presenter URL box, enter the URL of the source of streaming media 
content for presenters. 

- You can specify the height of the custom pane for attendees and for presenters 
in the corresponding Frame Height boxes. 

 

 

CONTENT 

When you set a content expiration time, all content associated with the meeting will be 
deleted after the time interval you specify. Setting an expiration time can be important 
when: 
 

 You do not want confidential content to persist on a server that does not belong to 
your company. 
 You want to delete information from your computer when it is no longer useful. 

 
To set content expiration options 
 
In the Content section of either the Meet Now Options page or the Meeting Options page, 
set the following options: 
 

 To delete content after a meeting ends, select the Delete all meeting content after 
meeting ends check box. 



  

 To specify the amount of time you want Conference Place to retain content, type a 
number in the Wait box, and then click a unit of time on the accompanying list. 

 

 
 
You set Audio options when you are first configuring an audio conferencing service for 
use with Conference Place or you are temporarily changing your audio preferences for a 
meeting (for example, calling participants directly rather than using audio conferencing). 
 
To set audio options 
 
In the Audio section of either the Meet Now Options page or the Meeting Options page, 
set the following options: 
 

1 In the ‘This meeting uses’ list, select the audio configuration you will use with 
Conference Place 

2 Select InterCall. 
3 If you want the Conference Place conference center to call participants, instead 

of requiring participants to dial in to the Conference Place conference center, 
select the  

4 Allow meeting participants to use ”Join Conference” check box (For 
Reservationless-Plus only). 

5 To display the audio conferencing toll-free and toll numbers to participants, as 
applicable: 

6 If you will use audio conferencing, configure the toll-free and toll meeting phone 
numbers by clicking a country or region on the Country/region list, and then 
typing the city or area code and local numbers in the text boxes provided. The 
number that appears above the Country/region list is the country code for the 
selected country or region. 



  

7 If you will use audio conferencing, also type the participant code and leader PIN 
in the text boxes provided. The leader PIN will never be revealed to the meeting 
participants, but it is necessary to connect to the audio conferencing providers. 

8 If you will record the meeting and if access will require additional dialing keys, 
type those keys into the text boxes provided in the Additional dialing keys 
section. 

 
NOTE: Keys added in the first box will be dialed before the participant code; keys added in the 
second box will be dialed following the participant code. 
 
For more information, see How to Set Up and Test Audio for Conference Place 2005. 

RECORDING  

You can choose to record a meeting or to allow other presenters to record it, and you can 
control meeting participants' access to the recording. 
 
To set recording options 
 
In the Recording section of either the Meet Now Options page or the Meeting Options 
page, set the following options: 
 

 In the Enable Recording section, click one of the following options: 
- To allow only yourself (as organizer) to record the meeting, click Disabled in the 

meeting, but the organizer can still record when logged into Conference Place. 
- To allow presenters to record the meeting, click the Presenters can record the 

meeting option. 
 In the Recording Access section, click one of the following options: 
- To allow only yourself and your Conference Place administrator access to 

recordings, click Only the administrator and organizer can view recordings. 
- To allow all attendees and presenters at the meeting to manage recordings, click 

All meeting participants can view recordings using their meeting entry 
information. 

 



  

 
 
For more information, see How to Record a Meeting. 

Recording a Meeting 
Conference Place provides a recording feature that lets you capture all keystrokes, slides, 
and audio of a meeting. After you record a meeting and save the recording, you can 
replay it later or make it available for training sessions, seminars, or for those who could 
not attend. 
 
NOTE: The recording feature does not capture PowerPoint animations, transitions, or builds; it 
captures only the final state of the slides. 
 
To record a meeting, follow these steps. The rest of this article explains these steps in 
detail. 

 

 



  

SET RECORDING AND AUDIO OPTIONS FOR MEETINGS 

Before you record a meeting, ensure that the Recording and Audio options are configured 
the way you want for both Meet Now meetings and scheduled meetings. 
 
To set recording options for Meet Now meetings 
 

 In your Internet browser, enter the URL of your Conference Place conference 
center. 
 At the My Home page of the Conference Place Manager, enter your User ID in the 
User  
 Login Field and your password in the Password box. 
 Click Meet Now Details, and then under Actions, click Meet Now Options. 
 At the top of the Meet Now Options page, click Recording. 
 By default, only the meeting organizer can record a meeting. If you want to allow 
presenters to record your meeting, select Presenter can record the meeting. 
 Under Recording Access, select how you want to control meeting access. By 
default, only the administrator and organizer can view recordings. 

 
To set audio options for Meet Now meetings 
 
For the Conference Place recording feature, you must specify additional dialing keys in 
addition to the phone numbers, the participant code, and the leader pin. The Conference 
Place recorder dials into the meeting as a silent attendee. You can use additional dialing 
keys to input the character string needed to allow the Conference Place to input your 
participant code for you. Each comma in the additional dialing keys causes the 
Conference Place recorder to pause in its dialing for one second. By adding commas, you 
can give the conference center prompt on the phone time to finish before dialing the 
participant code.  After the pause, the Conference Place recorder enters the participant 
code, followed by the next set of character strings that you specify. 
 
In the first Actual dialing keys box, type commas necessary for the first pause, and then in 
the field to the right of <participant code>, enter the characters that are required for the 
conference call service after the participant code is entered. 
 
 



  

 
 
To set recording options for scheduled meetings 
 

1 At the My Home page of the Conference Place Manager, enter your User Login 
ID in the User Login Field and your password in the Password field. 

2 Click Meeting Details, and then under Actions, click Meeting Options. 
3 At the top of the Meeting Options page, click Recording. 
4 By default, only meeting organizers can record a meeting. If you want to allow 

presenters to record the meeting, select Presenter can record the meeting. 
5 Under Recording Access, select how you want to control meeting access. By 

default, only the administrator and organizer can view recordings. 
 
To set audio options for scheduled meetings 
 

 In the first Actual dialing keys box, type commas necessary for the first pause, and 
then in the field to the right of <participant code>, enter the characters that are 
required for the conference call service after the particpant code is entered. 

RECORD A MEETING 

By default, only the meeting organizer can record a meeting, but the organizer can give 
permission to presenters to record the meeting as described earlier in this article. 
 
NOTE: These instructions assume that you have joined the meeting as either the organizer or 
as a presenter with permission to record, that you have set audio and recording options as 
described earlier in this article, and that you have imported the resources you need for the 
meeting. 
 
To record a meeting 
 
When the Conference Place console starts, the Audio and Recording Setup dialog box 
appears. The Phone Conferencing information will be provided in this dialog box. Call the 



  

Phone Conferencing Service using the telephone number supplied in the box. Be sure to 
supply your conference leader pin button on the Conference Place toolbar to import an 
Office document into the console. 
 
Before recording the meeting, import the resources you want for the meeting. For 
example, you can click the Import a Document button on the Conference Place toolbar. 
You may also want to wait for the meeting participants to arrive before you start recording 
the meeting. 
 
If you want to test the audio connection before recording, in the Audio and Recording 
Setup dialog box, click the double arrow to expand the recording section of the dialog box, 
and then click Test/Listen to Connection. 
 
When you are ready to start recording, click Start Recording in the Audio and Recording 
Setup dialog box. If the dialog box is not visible, click the Start Recording button on the 
Conference Place console toolbar. 
 
To pause a recording, click the Pause button. To resume recording after a pause, click 
the Pause button again.   
 
When you are finished recording, click the Stop Recording button. To save the recording, 
click Save Recording. The recording is saved to your conference center. 

ACCESS AND PLAY A RECORDING 

After recording the meeting, allow up to 24 hours for the recording to be available. After 
the meeting recording is complete, you, as the meeting organizer, must access the 
recording and provide access for others. 
 
To access and play a recording 
 

1 Log on to the Conference Place Manager. 
2 At the My Home page, click Recordings. 
3 In the Recordings list, click the View icon to the left of the recording name in the 

list. 
4 (Optional) To install the Replay Wrapper, a special skin for Windows Media 

Player that adds indexing ability to playback of your recordings, click Install Relay 
Wrapper and follow the instructions on the screen. 

5 In the View Recording in Replay format section, click the View icon. 
 
. 



  

 
 

SEND AN INVITATION TO A RECORDING 

When you set recording options before a meeting, you can either limit access to a 
recording to the organizer and the Conference Place administrator, or you can give 
access to all meeting participants. If you limit access to the organizer and the 
administrator, you can still provide access to individuals. To do so, you send those 
individuals an invitation to view the recording. 
 
To send an invitation to a recorded meeting 
 
On your My Home page, click Recordings. 
 
In the Recordings list, click the title of the meeting recording for which you want to send 
invitations. 
 
Optionally, you can change the recording access control and the download options. 
 
In the Invitees box, type the full e-mail addresses (for example, someone@example.com), 
separated by semicolons, of the people you want to invite to view the recording. 
 
Type an optional message, and then click Send Invitations. Invitees will receive an e-mail 
message with a link to the recording. 
 
 



  

 
 


